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WITH ILLUSTRATOR

Getting to Know lliustrator
Adobe Illustrator CS3 is a professional
illustration software application created by
Adobe Systems Incorporated. If this name

is familiar to you, it’s because Adobe is a
leading producer of graphics software

for the personal computer. Along with
Illustrator, Adobe produces an entire suite
of applications, including InDesign, Acrobat,
Type Manager, Dreamweaver, and, of course,
the revolutionary and award-winning
Photoshop.

With Illustrator, you can create everything
from simple graphics, icons, and text to
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complex and multilayered illustrations,
all of which can be used within a page
layout, in a multimedia presentation,
or on the Web.

Adobe Illustrator offers dozens of essential
tools. Using them in combination with
various menu commands, you have the
potential to create any illustration that
your imagination can dream up. With
experience, you will find that your ability
to create complex graphics rests on your
ability to master simple, basic operations.



Tools You’ll Use

Direct

Selection Tool
Selection Too/\

Shape tools

Rotate Tool

Swatches panel

Reflect Tool

Fill button

Stroke button M

Stroke panel




What You’ll Do

Name: The Lay of the Land Cx )
New Document Profile: [Custorm| - Cancel
Size: Letter - Templates...
Width: 8.5 in Units:  Inches -
Height: 11 1n Orientation: [[§]] (d) Color ModerCHYK
PP1:300
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\ In this lesson, you will start Adobe
Illustrator and create a new document.
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Creating a New Document
When you are ready to create a new
document in Tllustrator, you begin in the
New Document dialog box. In the New
document dialog box, you specify the
name of the document, which will appear
in the title bar of the new file. You also use
this dialog box to specify the document
size—the width and height of the finished
document. In addition, you can choose

the page orientation, landscape or portrait,
and the unit of measure you would like the
rulers to display. Some designers like to

Understanding native file types

NEW DOCUMENT

work with inches; others prefer points

or picas. Finally, you can choose the
appropriate color mode to work in based
on the type of document you are creating.

Choosing Color Modes and
Document Size

Generally, CMYK Color (Cyan, Magenta,
Yellow, and Black) is the color mode used
for print projects, and RGB Color (Red,
Green, and Blue) is the color mode used for
projects that will appear on a screen, such as
a monitor, a television or on the Web. The

The “native” Illustrator file format is noted as an .ai suffix. Native Illustrator files can
be opened and placed by other Adobe software packages, most notably Photoshop and
InDesign. If you want to save an Illustrator file for use in QuarkXPress, save the file
as an Illustrator EPS (Encapsulated PostScript). QuarkXPress does not recognize nor
does it import Illustrator files in the native .ai format.

Getting Started with Illustrator



New Document Profile menu in the New
Document dialog box allows you to specify
the type of document you need. You can
choose Print, Web, Mobile and Devices, Video
and Film, as well as Basic CMYK or Basic
RGB. The dialog box options available
depend on which profile you choose. For
example, if you choose Mobile and Devices,
the Color Mode changes to RGB, the unit of
measure changes to pixels, and the Device
Central button appears in the dialog box.
This button launches Adobe Device Central
which allows you to preview how your
document will appear on a specific device or
mobile phone. If you choose Print, the dialog
box will offer all of the appropriate settings
for a document that you intend to print.

Another method for specifying the color
mode is to click the expand button to the
left of the word Advanced, click the Color
Mode list arrow, then choose RGB or
CMYK.

Lesson 1  Create a New Document

Once a document is created, you may change
color mode settings by clicking File on the
menu bar, pointing to Document Color
Mode, then clicking CMYK Color or

RGB Color. In addition, once a document is
created, you can alter the current settings,
such as the page size, in the Document
Setup dialog box. The Document Setup com-
mand is on the File menu.

Choosing a Unit of Measure
Precision is often a key to good design, and
many designers choose points and picas as
units of measure. A point is % of an inch. A
pica is 12 points, or % of an inch. Defining
your artboard in points and picas versus
inches is a matter of personal preference.
As a designer, you're probably familiar with
points and picas, but would you really refer
to a letter-size page as 612 x 792 points?
On the other hand, when working in
inches, using measurements such as *%: of

an inch would also be a bit ridiculous.
Working with a combination of the two

is the best bet; many designers work in
points for text, rules, and strokes, but they
define the page itself in inches.

To set your preferences for units of meas-
ure, click Edit on the menu bar, point to
Preferences, then click Units & Display
Performance. Click the General, Stroke, and
Type list arrows to choose your preferred
unit of measure. The General setting
determines the units of measurement for
the page and objects on the page.

You'll certainly want to measure your
strokes and type in points. Imagine setting
type in %" Garamond!

QUICKTIP
If you are using a Macintosh, you will find the Preferences
command on the lllustrator menu.

Using the lllustrator Options dialog box

Let’s say that you have a friend, a co-worker, or a client that you want to send an
Ilustrator CS3 file to, but you find out that he or she never upgraded to CS3, and
therefore cannot open a CS3 file. No problem: Adobe Illustrator CS3 makes it easy to
save files that previous versions of Illustrator can open. Simply click the Save As
command on the File menu. In the Save As dialog box, choose Adobe Illustrator(*.AI),
then click Save. The Illustrator Options dialog box opens. Click the Versions list arrow,
then choose the format you need. CS Formats include CS3, CS2, and CS. Legacy
Formats include Illustrator 3, 8, 9, 10, and Japanese Illustrator 3.
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What You’ll Do

‘5516?3 In this lesson, you will learn about the key
7 architecture of the lllustrator window and
practice some basic lllustrator skills.
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ILLUSTRATOR WINDOW

Touring the lllustrator Window
Let’s take a few quick minutes to get the
lay of the land. It all starts here. If you
want to get really good at Illustrator, it’s
critical that you understand the workspace
and learn to how to manage it. Nothing
will slow down your work—and dull your
creativity—like wrestling with the applica-
tion. Moving around the window should
become second nature.

The Illustrator window includes the art-
board, scratch area, tools, and panels, all
of which are described below. Figure 3
shows some of the more commonly used
panels.

The title bar contains the name of your
document, magnification level, and color

mode; it also contains the Minimize,
Maximize, and Close buttons.

The menu bar includes all of the Illustrator
menus. If a menu item leads to a submenu,
a black triangle will be positioned to the
right. If a menu item requires you to enter
information into a dialog box, it is followed
by an ellipsis.

The artboard is the area, bound by a solid
line, in which you create your artwork; the
size of the artboard can be set as large as
227" x 227",

The scratch area is the area outside
the artboard where you can store objects
before placing them on the artboard;
objects on the scratch area will not print.

Getting Started with lllustrator



The Tools panel contains tools that let the last tool in the panel) to create a float- The Zoom text box in the lower-left cor-
you create, select, and manipulate objects ing toolbar. ner of the Illustrator window displays the

in Illustrator. A tiny black triangle beside a current magnification level. To the right of
the Zoom text box is the Zoom menu,

tool indicates “hidden” tools behind that QUICKTIP
tool. Pres§ and hold a too.l to expose the Click the tiny double arrows at the top left corner of which you access by clicking the Zoom list
panel of hidden tools behind it. Click the arrow. The Zoom menu lets you choose

the Tools panel to toggle between a two-column and

Tearoff tab (the tiny black triangle next to , another magnification level to work in.
a single-column Tools panel.

FIGURE 3
Ilustrator window
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The status bar contains a list arrow
menu from which you can choose a status
line with information about the current
tool, the date and time, the number of
undo operations, or the document color
profile.

Scroll bars run along the bottom and
right sides of the window; dragging the
scroll boxes, clicking in a scroll bar, or
clicking the scroll arrows changes the por-
tion of the document displayed in the
[llustrator window.

Panels are windows containing features
for modifying and manipulating Illustrator
objects. Panels are arranged in groups

on the right side of the workspace. Each
group is represented by a button. Simply
click a button to expand a panel group. To
expand all panel groups, click the Expand

ILLUSTRATOR 1-10

Dock button at the top of the panels
window. To resize the panels section of the
workspace, drag the three horizontal lines
to the left of the Expand Dock button.

Panels are grouped by function. For
example, if you click the Gradient button,
you'll see that the Gradient panel is
grouped with the Stroke and Transparency
panels. If you drag the top of the panel
group, all panels in the group move
together. You can separate panels from
their group by simply dragging the panel
name tab to a new location. You can also
merge two panels together by dragging a
panel name tab into a new group.

Docking panels allows you to arrange
multiple panels or panel groups vertically.
Like grouped panels, docked panels

move together. To dock a panel or a

panel group to another panel group,
drag one of the panel name tabs in the
group to the bottom edge of another
panel then release when the bottom edge
is highlighted.

Not all panels are represented by a button in
the Illustrator workspace, however, all panels
can be accessed using the Window menu.

TIP

You can temporarily hide all open panels and the Tools panel
by pressing [Tab]. Press [Tab] again to show the panels
and the Tools panel.

CKTIP
You can restore the default arangement of panels by click-
ing Window on the menu bar, pointing to Workspace, then

clicking [Basic].

Getting Started with Illlustrator



Using Quick Keys in lllustrator
Along with the various tools in the Tools
panel, the commands on the menu bar are
essential for performing both basic and
complex operations in Illustrator. Many of
the menu commands execute operations
that you will use over and over again.

For that reason, it is a smart idea to
memorize the quick keys associated with
the basic menu commands. When a

quick key is available, it is listed beside
the command in the menu.

Lesson 2 Explore the Illustrator Window

Many make the mistake of associating
quick keys with speed. True, using quick
keys will speed up your work, but the real
benefit of them is that they help your
work flow with fewer disruptions.
Leaving your keyboard, moving your
mouse, and clicking on a menu com-
mand all disrupt the essential flow of
your work. Quick keys allow you to
quickly execute a command without tak-
ing your hands off the keyboard or your
eyes off the monitor.

Quick keys are not for ‘power users’ only;
anybody working in Illustrator can use
them beneficially. Make learning quick
keys a fun part of your work; test yourself
along the way. They are so intuitively
assigned that you may even find yourself
guessing correctly!

In Illustrator, the best place to start
memorizing quick keys is with com-
mands on the File, Edit, and Object
menus, especially for Open, Close, Save,

ILLUSTRATOR 1-11



TIP

nageable area is the area inside the dotted line on the
ard, which is intended to represent the portion of the
that a default printer can print. Most designers find
otted line annoying and irrelevant. If it appears on
artboard, hide it by clicking Hide Page Tiling on the
menu.

1ips with the Adobe Creative

a file browser that allows you

) allows you to categorize your
and on the View menu, you

ate created, By File size, and By
'w your files, such as thumbnails,
ords and metadata to each file, and
es, such as files that call for a cer-
ved additional metadata into an
so, simply select the file in Bridge,
: left side of the dialog box are

2, and so on. However, if you click
1ation about the file, such as the
ion will then appear in the
To access Bridge, click File on the
> perfect tool to help you organize

Getting Started with Illustrator



TABLE 1: Essential lllustrator Quick Keys (Windows)

command

Outline

Preview

Fit in Window

Zoom In

Zoom Out

Access Hand Tool

Access the Zoom In Tool
Access the Zoom Out Tool
Select All

Windows command Windows
[Ctrl][Y] Deselect [Ctrl][Shift][A]
[Ctrl][Y] Cut [CtrI][X]
[CtrI][0] Copy [Ctr]][C]
[Ctrl][+] Paste [Ctrl][V]
[Ctrl][-] Paste in Front [Ctrl][F]
[Spacebar] Paste in Back [Ctrl][B]
[Ctrl][Spacebar] Undo [Ctrl][Z]
[Ctrl][Spacebar][Alt] Redo [Ctrl][Shift][Z]

[Ctrl][A]

TABLE 2: Essential lllustrator Quick Keys (Macintosh)

command

Outline

Preview

Fit in Window

Zoom In

Zoom Out

Access Hand Tool

Access the Zoom In Tool
Access the Zoom Out Tool
Select All

Macintosh

B3l

(=)1y]

B[

(#£][+]

E3§

[Spacebar]

[Spacebar]
[Spacebar][option]
()1a)

Lesson 2 Explore the Illustrator Window

command
Deselect

Cut

Copy

Paste

Paste in Front
Paste in Back
Undo

Redo

Macintosh
() (Shift][A]
(=X
(=ic)
E3l\
()[F)
(#¢)[B]
37
(#][Shift][Z]
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Navigate the lllustrator
artboard

1. Click File on the menu bar, click Open, navigate
to the drive and folder where your Data Files
are stored, click Al 1-1.ai, then click Open.

2. Click File on the menu bar, click Save As, type
Window Workout in the File name text box FIGURE 4
(Win) or the Save As text box (Mac), navigate Viewing the document in outline mode
to the drive and folder where your Data Files
are stored, click Save, then click OK to close
the lllustrator Options dialog box.

3. Click View on the menu bar, note the quick
key for Outline, then click Outline. x

As shown in Figure 4, outline mode shows the
skeleton of your work—the lines and curves
that you have drawn. Outline mode can be
useful for making very specific selections.

—

: . : Outline mode
4. Click View on the menu bar, note the quick shows the lines
key for Preview, then click Preview. and curves you
Preview mode shows your work complete have drawn

with the colors and styles you used.

5. Toggle between Outline and Preview modes
using the quick key, then return to Preview
mode.

6. Click the Zoom Tool | in the Tools panel,
then click the circle four times.

7. Click the Selection Tool BJ in the Tools panel.

8. Click View on the menu bar, then click Fit
in Window.

(continued)

ILLUSTRATOR 1-14 Getting Started with Illustrator



9. Click View on the menu bar, note the quick
keys for Zoom In and Zoom Out, then
release the menu.

10.Use the quick key to zoom in to 200%.

TIP " The current magnification level appears
in the title bar and the Zoom text box in the
lower-left corner.

FIGURE 5 11.Use the quick key to zoom out to 66.67%.

Moving the artboard with the Hand Tool 12.Press and hold [Spacebar], notice that the
pointer changes to the Hand Tool <2, then
click and drag the arthoard with the Hand
Tool, as shown in Figure 5.

The Hand Tool allows you to move the art-
board in the window; it’s a great alternative
to using the scroll arrows. Always press

[Spacebar] to access the Hand Tool, so as
not to interrupt the flow of your work.

You opened an Illustrator document, saved it with a
new name, and used menu commands and the
Zoom Tool to change the view size of the artboard.
You then used the Hand Tool to move the

artboard around.

Exploring the Adobe lllustrator CS3 Welcome Screen

When you start Adobe Illustrator CS3 for the first time, the Welcome Screen appears.
The Welcome Screen includes a list of recently opened items on the left and new
document templates on the right, such as Web Document and Mobile and Devices
Document. The From Template link leads you to pre-designed templates. Templates
can really help you jump-start a project if you're running out of time or need some
creative guidance. Templates are categorized into two categories: Basic and
Inspiration. Within those categories are many more. For example, in the Basic cate-
gory, you'll find more categories, such as Artist, Event Planning, and Environmental.
Within those folders are the actual templates, such as Business Card, Post Card, or
DVD Menu. If you've already installed CS3 and the Welcome Screen doesn’t open
when you launch the application, fear not! Simply click Help on the menu bar, then
click Welcome Screen. If you do not want the Welcome Screen to appear each time,
simply click the Don’t show again check box in the Welcome Screen dialog box.

Lesson 2 Explore the lllustrator Window ILLUSTRATOR 1-15



Work with objects

9.

. Click Select on the menu bar, then click All.

Click View on the menu bar, then click Show
Bounding Box, if necessary.

The bounding box is a box with eight hollow
white squares that appears around an object
or objects when selected.
[P If you see Hide Bounding Box on the
View menu, the bounding box is already
showing.
Click View on the menu bar, then click Hide
Bounding Box.

Click Select on the menu bar, then click
Deselect.

Click the Selection Tool M in the Tools
panel, then move each shape—one at
a time—to the bottom of the page.

Click Edit on the menu bar, then click
Undo Move.

The last object you moved returns to its
original position, as shown in Figure 6.

Undo your last two steps.

Click Edit on the menu bar, then click
Redo Move.

Redo your last two steps.

10.Click the artboard to deselect, click the red

triangle, click Edit on the menu bar, then
click Copy.

11.Click Edit on the menu bar, theh click Paste.

(continued)
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FIGURE 6
Undoing your last step

The last object
you moved
returns to its
original position
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FIGURE 7
Copying and pasting the triangle

(M 4

Lesson 2 Explore the Illustrator Window

Third triangle
moved after
being copied
and pasted
in back

Second trian-
gle created
from copy
and paste

Original
triangle

12.Copy the new triangle, click Edit on the
menu bar, then click Paste in Back.

The Paste in Front and Paste in Back com-
mands paste the copied object from the clip-
board in front or in back of a selected object.
If you select an object, copy it, and then
choose Paste in Front; the copy will be
pasted above the original in exactly the same
location.

13.Move the top red triangle to expose the
copied triangle pasted behind it, as shown in
Figure 7.

14.Save your work, then close Window
Workout.

You moved objects on the artboard and used the
Undo and Redo commands on the Edit menu. You
selected and copied objects, then applied the Paste
in Back command to position a copy precisely in
back of its original.
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What You’ll Do
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o In this lesson, you will examine the differ-
ences between bitmap and vector graph-
ics. Then you will use the Rectangle Tool
to examine lllustrator’s various options for
creating simple vector graphics.
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Getting Ready to Draw

Are you eager to start drawing? Do you
want to create complex shapes, special
effects, and original art? Perhaps you are a
self-taught user of Adobe Illustrator, and
your main interest is to graduate to
advanced techniques and add a few of
those cool special effects to your skill set.
Good for you! Enthusiasm is priceless, and
no book can teach it. So maintain that
enthusiasm for this first exercise, where
you'll start by creating a square. That’s
right . . . a square.

Consider for a moment that Mozart’s
sublime opera Don Giovanni is based
primarily on eight notes, or that the
great American novel can be reduced to
26 letters. Illustrator’s foundation is
basic geometric shapes, so let’s start at
square one . . . with one square.

Don’t rush. As you work, keep in mind
that the lessons you will learn here are the
foundation of every great illustration.

Understanding Bitmap Images
and Vector Graphics

Computer graphics fall into two main
categories—bitmap images and vector
graphics. To create effective artwork, you
need to understand some basic concepts
about the two.

Bitmap images are created using a
square or rectangular grid of colored
squares called pixels. Because pixels

(a contraction of “picture elements”) can
render subtle gradations of tone, they are
the most common medium for continu-
ous-tone images—what you perceive as

a photograph. All scanned images are
composed of pixels. All “digital” images
are composed of pixels. Adobe Photoshop
is the leading graphics application for
working with digital “photos.” Figure 8
shows an example of a bitmap image. The
number of pixels in a given inch is
referred to as the image’s resolution. To
be effective, pixels must be small enough
to create an image with the illusion of
continuous tone. Thus, bitmap images
are termed resolution-dependent.

Getting Started with Illustrator



The important thing to remember about
bitmap images is that any magnification—
resizing the image to be bigger—essentially
means that fewer pixels are available per
inch (the same number of pixels is now
spread out over a larger area). This
decrease in resolution will have a negative
impact on the quality of the image. The
greater the magnification, the greater the
negative impact.

Graphics that you create in Adobe
Illustrator are vector graphics. Vector
graphics are created with lines and curves
and are defined by mathematical objects

FIGURE 8
Bitmap graphics

called vectors. Vectors use geometric char-
acteristics to define the object. Vector
graphics consist of anchor points and line
segments, together referred to as paths.

For example, if you use Illustrator to render
a person’s face, the software will identify the
iris of the eye using the mathematical defi-
nition of a circle with a specific radius and a
specific location in respect to other graph-
ics. It will then fill that circle with the color
you have specified. Figure 9 shows an
example of a vector graphic.

Computer graphics rely on vectors to ren-
der bold graphics that must retain clean,

crisp lines when scaled to various sizes.
Vectors are often used to create logos or
“line art,” and they are the best choice for
typographical work, especially small and
italic type.

As mathematical objects, vector graphics
can be scaled to any size. Because they are
not created with pixels, there is no inherent
resolution. Thus, vector graphics are
termed resolution-independent. This
means that any graphic that you create in
[lustrator can be output to fit on a postage
stamp or on a billboard!

FIGURE 9
Vector graphics

Lesson 3  Create Basic Shapes
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Use the Rectangle Tool

1. Click File on the menu bar, click New, create a
new document that is 8" wide by 8" in height,
name the file Basic Shapes, then click OK.
Click File on the menu bar, click Save As, nav-
igate to the drive and folder where your Data
Files are stored, click Save, then click OK to
close the lllustrator Options dialog box.
3. Click View on the menu bar, then click Hide
Page Tiling, if necessary.
4. Click the Swap Fill and Stroke button "l
in the Tools panel to reverse the default colors.
Your fill color should now be black and your
stroke color white. The fill color is the inside
color of an object. The stroke color is the
color of the object’s border or frame.
. Click the Rectangle Tool 2. in the Tools
panel.
6. Click and drag the Rectangle Tool pointer
on the artboard, then release the mouse to

N

FIGURE 10
Creating a rectangle and a square

4]

make a rectangle of any size. Square created by
7. Press and hold [Shift] while you create a pmgsmg [Sﬁ/ff]
second rectangle. while creating a
rectangle

Pressing and holding [Shift] while you cre-
ate a rectangle constrains the shape to a
perfect square, as shown in Figure 10.

8. Create a third rectangle drawn from its center
point by pressing and holding [Alt] (Win) or
[option] (Mac) as you drag the Rectangle
Tool pointer.

TP Use [Shift] in combination with [Alt]
(Win) or [option] (Mac) to draw a perfect
shape from its center.

You created a freeform rectangle, then you created

a perfect square. Finally you drew a square from

its center point.
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FIGURE 11

Rectangle dialog box
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LESSON 4

What You’ll Do

In this lesson you will use the Swatches
panel to add a color fill to an object and
apply a stroke as a border. Then you will
use the Stroke panel to change the size of
the default stroke.

ILLUSTRATOR 1-22
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COLORS TO OBJECTS

Activating the Fill or Stroke
The Fill and Stroke buttons are at the bot-
tom of the Tools panel. To apply a fill or
stroke color to an object, you must first
activate the appropriate button. You acti-
vate either button by clicking it, which
moves it in front of the other. When the
Fill button is in front of the Stroke

button, the fill is activated, as shown in
Figure 12. The Stroke button is activated
when it is in front of the Fill button.

As you work, you will often switch back
and forth, activating the fill and the stroke.
Rather than using your mouse to activate
the fill or the stroke each time, simply
press [X] to switch between the two modes.

FIGURE 12
Fill and Stroke buttons

Default Fill and —
Stroke button

Stroke button

™ Stroke button
(not activated)

Fill button (activated)
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Applying Color with the
Swatches Panel

The Swatches panel as shown in Figure 13,
is central to color management in the appli-
cation and a simple resource for applying fills
and strokes to objects.

The panel has 48 preset colors, along with
gradients and patterns. The swatch with

the red line through it is called [None]
and used as a fill for a “hollow” object. Any
object without a stroke will always have
[None] as its stroke color.

When an object is selected, clicking a
swatch in the panel will apply that color
as a fill or a stroke, depending on which

FIGURE 13
Swatches panel

j Swatches X |

patterns

Lesson 4 Apply Fill and Stroke Colors to Objects

of the two is activated in the Tools panel.
You can also drag and drop swatches onto
unselected objects. Dragging a swatch to
an unselected object will change the color
of its fill or stroke, depending upon which
of the two is activated.

Forty-gight pre-set colors, gradients and
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FIGURE 14
Red stroke is added to the yellow square
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FIGURE 15
Yellow square without a stroke

Lesson 4 Apply Fill and Stroke Colors to Objects




Vhat You’ll Do

In this lesson, you will use the Selection
Tool in combination with Smart Guides to
move, copy, and align four squares.
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ALIGN OBJECTS

Selecting and Moving Objects
When it comes to accuracy, consider that
Illustrator can move objects incremen-
tally by fractions of a point—which itself
is a tiny fraction of an inch! That level of
precision is key when moving and posi-
tioning objects.

Before you can move or modify an
Ilustrator object, you must identify it by
selecting it with a selection tool, menu
item, or command key. When working
with simple illustrations that contain few
objects, selecting is usually simple, but it
can become very tricky in complex illus-
trations, especially those containing a
large number of small objects positioned
closely together.

Two very basic ways to move objects are
by clicking and dragging or by using
the arrow keys, which by default move
a selected item in 1-pt increments.
Pressing [Shift] when dragging an

object constrains the movement to the
horizontal, the vertical, and 45° diago-
nals. Pressing [Alt] (Win) or [option]
(Mac) when dragging an object creates
a copy of the object.

Grouping Objects

Many of the illustrations you create will be
composed of a number of small objects.
Once you have established the relation-
ships among those objects, grouping them
allows you to select them all with one click
of the Selection Tool and then move or
modify them simultaneously. To group
objects, click them, click Object on the
menu bar, then click Group.

Making a Marquee Selection
with the Selection Tool

By now, you're familiar with using the
Selection Tool to select objects. You can
also use the Selection Tool to create a
marquee selection, a dotted rectangle that
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disappears as soon as you release the
mouse. Any object that the marquee
touches before you release the mouse will
be selected. Marquee selections are very
useful for both quick selections and precise
selections. Practice, and make this part of
your skill set.

Working with Smart Guides
Smart Guides are temporary guides that

can be turned on and off on the View menu.

Smart Guides help you move and align
objects in relation to other objects or in
relation to the artboard. With Smart
Guides turned on, you will see words,
called Smart Guides, that identify visible or
invisible objects, page boundaries, intersec-
tions, anchor points, paths, and center
points as you move your mouse along the
objects on the artboard. When you move an
object, Smart Guides give you a visual ref-
erence for precise alignment, as shown in
Figure 16. For example, if you want to
align two squares exactly side by side,
Smart Guides will signal you when the two
items come into contact, using the word
“intersect.”

Lesson 5 Select, Move, and Align Objects

FIGURE 16
Using Smart Guides
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FIGURE 17
Anchor points, paths, and center point

Anchor points

Center point

FIGURE 18
Intersecting two points

=

N

When the top-left anchor point /
of the square meets the top-left
corner of the artboard, the word
"intersect" appears
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FIGURE 19
Duplicating the square

A copy of the original square

FIGURE 20
Four squares created using drag and drop

Lesson 5 Select, Move, and Align Objects

1

4.

Duplicate objects using drag
and drop

. Click the top-left anchor point, press and
hold [Shift][Alt] (Win) or [Shift][option]
(Mac), drag straight down until the top-left
anchor point touches the bottom-left anchor
point (the “intersect” Smart Guide will
appear), then release the mouse.

When moving an object, pressing and hold-
ing [Shift] constrains the movement verti-
cally, horizontally, or on 45° diagonals.
Pressing [Alt] (Win) or [option] (Mac) while
dragging an object creates a copy of the
object, as shown in Figure 19.
TP When you press [Alt] (Win) or [option]
(Mac) while dragging an object, the pointer
becomes a double-arrow pointer. When two
anchor points are directly on top of each
other, the Selection Tool pointer turns from
black to white.
With the bottom square still selected, press
and hold [Shift], then click the top square to
select both items.

Click the top-left anchor point of the top
square, press and hold [Shift][Alt] (Win) or
[Shift][option] (Mac), drag to the right until
the top-left anchor point touches the top-
right anchor point, then release the mouse.

Change the fill color of each square to match
the colors shown in Figure 20.

5. Save your work.

You moved and duplicated the yellow square using
[Shift] to constrain the movement and [Alt] (Win)
or [option] (Mac) to duplicate or “drag and drop”
copies of the square.
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What You’ll Do

@ In this lesson, you will scale, rotate, and
reflect objects, using the basic transform
tools. You will also create a star and a
triangle.
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Transforming Objects

The Scale, Rotate, and Reflect Tools are
the fundamental transform tools. As their
names make clear, the Scale and Rotate
Tools resize and rotate objects, respec-
tively. Double-click a transform tool to
open the tool’s dialog box. When you use
the tool’s dialog box, the objects are trans-
formed from their centerpoints. This can
be a useful choice, because the object’s
position essentially doesn’t change on the
artboard or in relation to other objects.

Use the Reflect Tool to “flip” an object
over an imaginary axis. The best way to
understand the Reflect Tool is to imagine

OBJECTS

positioning a mirror perpendicular to a
sheet of paper with a word written on it.
The angle at which you position the
mirror in relation to the word is the
reflection axis. The reflection of the word
in the mirror is the end result of what the
Reflect Tool does. For example, text
reflected across a horizontal axis would
appear upside down and inverted. Text
reflected across a vertical axis would
appear to be inverted and running back-
wards, as shown in Figure 21.

You can transform an object using the
desired tool or its dialog box. Each trans-
form tool has a dialog box where you can
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enter precise numbers to execute the
transformation on a selected object. You
can access a tool’s dialog box by double-
clicking the tool. Click the Copy button in
the dialog box to create a transformed
copy of the selected object. Figure 22
shows the Scale dialog box.

Repeating Transformations

One of the most powerful commands relat-
ing to the transform tools is Transform

FIGURE 21
Reflected text

K SI6CE

Reflect

Reflect
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Again, found on the Object menu.
Unfortunately, it is a command often over-
looked by new users. Whenever you trans-
form an object, selecting Transform Again
repeats the transformation. For example, if
you scale a circle 50%, the Transform Again
command will scale the circle 50% again.

The power of the command comes in com-
bination with copying transformations. For
example, if you rotate a square 10° and

copy it at the same time, the Transform
Again command will create a second
square, rotated another 10° from the first
copy. Applying Transform Again repeatedly
is very handy for creating complex geomet-
ric shapes from basic objects.

FIGURE 22
Scale dialog box

@ Uniform
Scale: %
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[T]Scale Strokes & Effects
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ILLUSTRATOR 1-31



3.

5.

. Select the green square, double-click the
Scale Tool =%, type 50 in the Scale text
box, then click OK.

Click Edit on the menu bar, then click
Undo Scale.

TP You can also undo your last step by
pressing [Ctrl][Z] (Win) or [Z] (Mac).
Double-click the Scale Tool % again, type

50 in the Scale text box, then click Copy.

The transformation is executed from the
center point; the center points of the original
and the copy are aligned.

Fill the new square created in Step 3 with blue.

Double-click the Rotate Tool jj type 45 in
the Angle text box, click OK, then click the
Selection Tool X .

Apply a 22 pt, yellow stroke to the rotated
square, deselect, then compare your screen
to Figure 23.

You used the Scale Tool to create a 50% copy of
the square, then filled the copy with blue. You
rotated the copy 45°. You then applied a 22 pt,
yellow stroke.
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FIGURE 23
Scaling and rotating a square
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FIGURE 24
Using the Transform Again command

Lesson 6 Transform Objects




FIGURE 25
Star dialog box
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FIGURE 26
Reflect dialog box
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FIGURE 27
Reflecting the star horizontally

FIGURE 28
The finished project
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Selecting

The Select menu offers some powerful selection commands under the Same sub-
menu. There you have commands to select by the same fill, stroke, fill and stroke,
stroke color, and stroke weight. You can even select objects with the same opacity
and blending mode applied. When it comes to selecting multiple objects, using the
Select menu is much faster than Shift-clicking!

Lesson 6 Transform Objects

7. Use the Selection Tool X or the arrow keys

on your keyboard to position the star
roughly in the center of the red square.

Your work should resemble Figure 27.

[P Arrow keys move a selected item in

1 pt increments, known as the Keyboard
Increment. You can change this amount by
clicking Edit (Win) or Illustrator (Mac) on
the menu bar, pointing to Preferences, click-
ing General, then typing a new value in the
Keyboard Increment text box.

8. Click the Polygon Tool 4@ in the Tools panel.

The Polygon Tool is hidden beneath the
current shape tool in the Tools panel.

9. Click anywhere on the blue square.

10.Type 1.5 in the Radius text box, type 3 in the
Sides text box, then click OK.

11.Fill the triangle with red.

12.Change the stroke color to yellow and the
stroke weight to 22 pt.

13. Position the triangle so that it is centered
within the blue square.

Your completed project should resemble
Figure 28.

14.Save your work, then close Basic Shapes.

You used the shape tools to create a star and a tri-
angle and used the Reflect Tool to “flip” the star
over an imaginary horizontal axis.
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What You’ll Do

In this lesson, you will use the Direct
Selection Tool and a combination of menu
commands, such as Add Anchor Points
and Paste in Front, to convert existing
shapes into new designs.
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SELECTIONS

Using the Direct

Selection Tool

The Direct Selection Tool selects individ-
ual anchor points or single paths of an
object. Using [Shift], you can select mul-
tiple anchor points or multiple paths. You
can also select multiple points or paths by
dragging a direct selection marquee. The
tool also selects individual objects within
a group, which can be very useful for
modifying just one object in a complex
group. Figure 29 demonstrates the Direct
Selection Tool selecting one piece of a
grouped object.

Clicking the center of an object with the
Direct Selection Tool selects the entire
object. Clicking the edge selects the path
only. You will know you have made this
direct selection successfully if the anchor
points on the object all appear white. A
white anchor point is not selected.

The Direct Selection Tool gives you the
power to distort simple objects such as
squares and circles into unique shapes.
Don’t underestimate its significance. While
the Selection Tool is no more than a means

to an end for selecting and moving objects,
the Direct Selection Tool is in itself a draw-
ing tool. You will use it over and over again
to modify and perfect your artwork.

Adding Anchor Points

As you distort basic shapes with the Direct
Selection Tool, you will often find that to
create more complex shapes, you will need
additional anchor points to work with.

The Add Anchor Points command creates
new anchor points without distorting the
object. To add anchor points to an object,
click the Object menu, point to Path, then
click Add Anchor Points. The new points are
automatically positioned exactly between
the original anchor points. You can create as
many additional points as you wish to use.

Turning Objects into Guides
Guides are one of Illustrator’s many features
that help you to work with precision. Any
object you create can be turned into a guide.
With the object selected, click the View
menu, point to Guides, then click Make
Guides. Guides can be locked or unlocked in
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the same location. It is a good idea to work
with locked guides so that they don't interfere
with your artwork. Unlock guides only when
you want to select them or delete them.

FIGURE 29
Using the Direct Selection Tool

Direct Selection Tool
selects single objects
within groups
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When an object is turned into a guide, it
loses its attributes, such as its fill, stroke,
and stroke weight. However, Illustrator
remembers the original attributes for each

guide. To transform a guide back to its
original object, first unlock, then select the
guide. Click the View menu, point to
Guides, then click Release Guides.

Direct Selection Tool
selects anchor points
and paths
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1. Open Al 1-2.ai, then save it as Direct
Selections.

[IP Each time you save a Data File,
click OK to close the Illustrator Options
dialog box.

2. Click View on the menu bar, then click
Smart Guides to turn this feature off.
3. Select the green polygon.

4. Click View on the menu bar, point to Guides,
then click Make Guides.

The polygon is converted to a guide.

[IP"If you do not see the polygon-shaped
guide, click View on the menu bar, point to
Guides, then click Show Guides.

5. Convert the purple starburst to a guide.
6. Click View on the menu bar, point to Guides,

verify that there is a check mark to the left of
Lock Guides, then release the mouse.

7. Click the Direct Selection Tool X ., then
click the edge of the red square.

The four anchor points turn white, as shown
in Figure 30.

8. Click and drag the anchor points to the four
corners of the guide to distort the square.
Your work should resemble Figure 31.

You converted two objects into guides. You then

used the Direct Selection Tool to create a new

shape from a square by moving anchor points
independently.
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FIGURE 30
Red square selected with the Direct Selection Tool

AN Objects converted

into guides

[

Anchor points
are hollow

FIGURE 31
Red square distorted
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FIGURE 32
Star selected with Direct Selection Tool

FIGURE 33
Completed starburst

Making a direct selection marquee
When you create a marquee selection with the Selection Tool, any object the mar-
quee touches is selected in its entirety. You can also use the Direct Selection Tool to
create selection marquees. A Direct Selection Tool marquee selects only the anchor
points and the paths that it touches. A Direct Selection Tool marquee is very useful
for selecting multiple points or paths in one step.
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FIGURE 34
Viewing the path of the circle

Clicking the edge of an object with the
Direct Selection Tool selects one line
segment of the entire path

FIGURE 35
Completed circle
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FIGURE 36
Completed linked squares
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Start lllustrator and create a new

document.

1. Create a new document and name it Flag.

2. Make the size of the document 6" x 4".

3. Select Inches for the type of units, and CMYK
Color for the color mode, then click OK.

4. Click File on the menu bar, click Save As,
navigate to the drive and folder where you
store your Data Files, then click Save.

5. Click View on the menu bar, then click Hide
Page Tiling, if necessary.

6. Create a circle at the center of the arthoard.

7. Click the Selection Tool.

Explore the lllustrator window.

1.

Click View on the menu bar, then

click Outline.

Click View on the menu bar, then

click Preview.

Click View on the menu bar, then click
Zoom In.

Click View on the menu bar, then click
Zoom QOut.

Press and hold [Spacebar] to access the
Hand Tool, then move the arthoard.

Click View on the menu bar, then click Fit
in Window.

Select the circle, click Edit on the menu bar,
then click Copy.
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1.

12.
13.

14.

15.

Click Edit on the menu bar, then click Paste
in Front.

Move the new circle to the bottom of the
artboard.

. Click Edit on the menu bar, then click

Undo Move.

Click Edit on the menu bar, then click
Redo Move.

Click Select on the menu bar, then click All.
Click Select on the menu bar, then click
Deselect.

Select all of the objects, click Edit on the
menu bar, then click Cut.

Save your work.

Create basic shapes and apply fill and
stroke colors.

1.

2.
3.
4.

Set the Fill and Stroke buttons in the Tools
panel to black and [None], respectively.
Create a rectangle that is 3" x 1".

Show the Swatches panel, if necessary.
Fill the rectangle with a light yellow.

Select, move, and align objects.

i

Click View on the menu bar, then click
Smart Guides, if necessary.

Move the rectangle so that its top-left
anchor point intersects with the top-left cor-
ner of the artboard.

Click the top-left anchor point, press and
hold [Shift][Alt] (Win) or [Shift][option]
(Mac), drag straight down until the top-left
anchor point touches the bottom-left anchor

V-

point (the “intersect” Smart Guide appears),
then release the mouse.

Click Object on the menu bar, point to
Transform, then click Transform Again.
Repeat Step 4.

Change the fill color of the second and
fourth rectangles to a darker yellow.

Save your work.

Transform objects.

1s
2.

Select the four rectangles.

Double-click the Reflect Tool, click the
Horizontal option button, then click Copy.
The four rectangles are copied on top of the
original rectangles.

Move the four new rectangles to the right so
that they align with the right side of the
artboard.

Click the Rectangle Tool, click the artboard,
and create a square that is .75" x .75".

Apply a 1-point black stroke to the square
and no fill.

Click the Selection Tool, click the edge of the
square, then position it at the center of the
artboard.

Use the Rotate dialog box to create a copy
of the square rotated at 10°.

Apply the Transform Again command

seven times.

Save your work.
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Make direct selections. FIGURE 37

1. Use [Shift] to select each of the nine black S e g
squares.

2. Click Object on the menu bar, then
click Group.

3. Scale the group of squares 200%.

4. Create a 3.75" x 3.75" circle, fill it with
orange, add a 1-point black stroke, then
position it at the center of the artboard.

5. Cut the circle from the artboard, click the
group of black squares, click Edit on the
menu bar, then click Paste in Back.

6. Adjust the location of the circle, as needed.

7. Click Object on the menu bar, point to Path,
then click Add Anchor Points.

8. Deselect the circle by clicking anywhere on
the artboard.

9. Click the Direct Selection Tool, then click the
edge of the circle.

10. One at a time, move each of the four new
anchor points to the center of the circle.

11. Switch to the Selection Tool, then select the
orange-filled shape.

12. Double-click the Rotate Tool, type 22 in the
Angle text box, then click Copy.

13. Apply the Transform Again command
two times.

14. Save your work, then compare your illustra-
tion to Figure 37.

15. Close the Flag document.

x4
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The lady who owns the breakfast shop that
you frequent knows that you are a designer
and asks for your help. Her nephew has
designed a sign for her store window, but
she confides in you that she doesn’t like it.
She thinks that it’s “boring” and “flat.” She
wants to redesign the sign with something
that is “original” and feels “more like a
starburst.”

1. Open Al 1-3.ai, then save it as Window
Sign.

2. Click the Direct Selection Tool, then click the
edge of the star.

3. Move two of the outer anchor points of the
star farther from its center.

4. Move four of the inner points toward
the center.

5. Select the entire star.

6. Reflect a copy of the star across the
horizontal axis.

7. Fill the new star with an orange swatch and
reposition it to your liking.

8. Group the two stars.

9. Copy the group, then paste in back.

10. Fill the copies with black.

11. Using your arrow keys, move the black
copies five points to the right and five
points down.
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12. Select only the orange star using the Direct
Selection Tool.

13. Copy the orange star, then paste in back.

14. Fill the new copy with black.

15. Rotate the black copy 8°.

FIGURE 38
Completed Project Builder 1

D

Linda's Starburst Cafe

16. Apply a yellow fill to the orange star, then
apply a 1-point black stroke to both yellow
stars.

17. Save your work, then compare your
illustration to Figure 38.

18. Close Window Sign.
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Iris Vision Labs has contracted with your
design firm to bid on a design for their
logo. Researching the company, you
learn that they are a biotech firm whose
mission is to develop cures for genetic
blindness and vision problems. You
decide to build your design around the
idea of an iris.

Create a new document that is 6" x 6".
Save the document as Iris Vision Design.
Create an ellipse that is 1" wide x 4" in
height, and position it at the center of the
artboard.

Fill the ellipse with [None], and add a 1-point
blue stroke.

Create a copy of the ellipse rotated at 15°.
Apply the Transform Again command

10 times.

Select all and group the ellipses.

Create a copy of the group rotated at 5°.
Apply a red stroke to the new group.

. Transform again.

. Apply a bright blue stroke to the new group.
. Select all.

. Rotate a copy of the ellipses 2.5°.

. Create a circle that is 2" x 2".

. Fill the circle with a shade of gray.

. Remove the stroke from the circle.

. Position the gray-filled circle in the center

of the ellipses.
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18. Cut the circle.
19. Select all.
20. Paste in back.

FIGURE 39
Completed Project Builder 2

21. Save your work, then compare your
illustration to Figure 39.
22. Close Iris Vision Design.
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DESIGN PROJECT

The owner of Emerald Design Studios has FIGURE 40
Completed Design Project

hired you to design an original logo for
her new company. She’s a beginner with
Illustrator, but she’s created a simple
illustration of what she has in mind. She
tells you to create something “more
sophisticated.” The only other informa-
tion that she offers about her company is
that they plan to specialize in precise,
geometric design.

1. Open Al 1-4.ai, then save it as
Emerald Logo.

2. Select all four diamonds and group them.

3. Select the group of diamonds on the art-
board, then create a 75% copy.

4. Use the Transform Again command
five times.

5. Use Smart Guides or Outline mode to help
you identify each of the seven groups.

6. Rotate one of the groups 75°.

7. Select two other groups of your choice and
repeat the last transformation, using the
Transform Again command.

8. Apply a dark green stroke to all groups.
Figure 40 shows one possible result of mul-
tiple transformations. Your illustration may
differ.

9. Save your work, then close Emerald Logo.
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You attend a design school, and you're
part of a team that is responsible for the
artwork placed throughout the common
areas of the school. One of the most
admired professors brings you a file that
he created in Illustrator, admitting that
he’s a beginner. Your team opens the file
and notices that the file is poorly built—
everything is misaligned and uneven.
After consulting with the professor, your
team decides that the file needs to be
rebuilt from scratch.

1. Open Al 1-5.ai, then save it as Rings.

2. Distribute copies of the file to the members
of your group.

3. Discuss with the group the areas of the file
that are misaligned and poorly constructed.

4. Assign one member the task of pulling apart
the file, object by object, to see how the
effect was achieved.

5. Have the group create a “game plan” for
reproducing the artwork with precision.
Where’s the best place to start? What’s the
best methodology for recreating the profes-
sor’s design?

6. Have a group discussion about the art itself.
If the professor is open to new ideas, how
would the group suggest that the design
could be improved?

Getting Started with Illustrator

7. Have one member work on the original
lllustrator file.

8. Work as a group to rebuild the file, using
precise methods.

FIGURE 41
Completed Group Project

9. Save your work, then compare your illustra-
tion to Figure 41.
10. Close the Rings document.
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